8
WORKING WITH TEXT

8.1 INTRODUCTION

This lesson covers various features of text processing such as mov-
ing text from one place to another place in the document, creating
bulleted and numbered lists, creating and applying styles, and spell-
ing and grammar corrections that are important to enrich your docu-
ment. Also, enriching a document’s appearance is Word’s specialty.
Word’s formatting features allow you to create beautiful documents
without doing much more than typing headings and text. Word will
do the rest. Word offers a great amount of formatting options: multi-
ply typefaces and point sizes; easy-to-apply character styles such as
bold, italic, normal, single and double underline; subscript and su-
perscript; and paragraph formats such as alignment, spacing and
indentation.

8.2 OBJECTVIES

After going through this lesson you would be able to
e explain basic text processing tips

e define character and paragraph formats

e create bulleted and numbered lists

e explain spelling and grammar features
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8.3 WORKING WITH TEXT

While using Word program, there are certain concepts, tips, and
commands you should learn sooner, rather than later. This section
deals with most common Word concepts, tips, and commands you
should know regardless your skills in using Word program.

8.3.1 Typing Text

To enter text, just start typing! The text will apear where the blink-
ing cursor is located. Unlike with a typewriter, you need not press
ENTER key at the end of each line. Continue to let your text wrap
around until you are ready to start a new paragraph. Press ENTER
key at the end of a paragraph.

8.3.2 Wrapping Words Together

If you want that two words (such as name of a place or person having
more than one word), always wrap to the next line together, put a
nonbreaking space between them. The keyboard combination for a
nonbreaking space is CTRL+SHIFT+ SPACEBAR. For example, if
you want the word ‘New Delhi’, should appear in the same line,
press CTRL+SHIFT+SPACEBAR between ‘New’ and ‘Delhi’. Simi-
larly, you can press the above key combination to wrap dates ( day
and month & month and year).

8.3.3 Inserting Text.

To insert the text in an existing document, follow the steps given
below:

1. Move the cursor by using the arrow buttons on the keyboard or
positioning the mouse and clicking the left button where you
want to insert the text. The keyboard shortcuts listed below are
also helpful when moving through the text of a document.

Beginning of the line HOME

End of the line END

Top of the document CTRL+HOME

End of the document CTRL+END
2. Type the text you want to insert.
8.3.4 Spacebar and Tabs

Use the spacebar as a separator for your words and sentences. Don’t
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use the spacebar to move the insertion point across a line of text -
known as “spacing across a line”. The spacebar method works in a
typewriter as a way of moving across a line, but it does not work in
word processing. If you use the spacebar to move around, word will
make additional spaces, which you will then have to delete. Avoid
using the spacebar to create columns of text. Instead you can use
the Tab key.

8.3.5 Paragraph Markers

You may find it easier to type when you can see the returns, spaces,
and tabs in your document. If so, click on the Show/Hide button on
the Standard toolbar to display, the marks. Click on the symbol
again to hide them.

8.3.6 Selecting (Highlighting) Text

To change any attributes of text it must be highlighted first. Select
the text by dragging the mouse over the desired text while keeping
the left mouse button depressed, or hold down the SHIFT key on
the keyboard while using the arrow buttons to highlights the text.
The shortcuts for selecting a portion of the text are:

a. To select whole word double-click within the word.
b. To select whole paragraph triple-click within the paragraph.

c. To select several words or lines drag the mouse over the words, or
hold, down SHIFT key while using the arrow keys.

d. To select entire document choose Edit 2 Select All command on
the menu bar, or press CTRL+A keys.

e. To deselect the text click anywhere outside of the selection on
the page or press an arrow key on the keyboard.

8.3.7 Deleting Text

Use the BACKSPACE and DELETE keys on the keyboard to delete
text. Backspace will delete the text to the left of the cursor and
Delete will erase the text to the right. To delete a large selection of
text, highlight it using any of the methods outlined above and press
the DELETE key.

8.3.8 Caps Lock

When Caps Lock (a key on the keyboard) is off, any text you type
will be lowercase, and the text you type holding down the Shift key
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will be in upper case. On the other hand, when Caps Lock is on, any
text you type will be in uppercase, and the text you type holding
down the Shift key will be in lowercase. If you inadvertently type a
bit of text with the Caps Lock on, select the text and choose Format
- Change Case 2 TOGGLE cASE command on the menu bar to
change the case back to normal.

If you inadvertently type a bit of text with only uppercase text and
want to change it to lowercase text, select the text and choose For-
mat - Change Case > lowercase command on the menu bar. On
the other hand, if you want to change lowercase text to uppercase,
select the text and choose Format <> Change Case > UPPER CASE
command on the menu bar to change the case back to normal.

8.3.9 Replacing Text

Word can combine the steps of deleting unwanted text, positioning
the insertion point, and inserting replacement text. To replace text,
follow the steps given below:

1. Select the text to be removed.

2. Start typing the new text. Observe that the new text is replacing
the selected text.

You can also replace the text by selecting the text, then deleting it
using DELETE key, and then start typing new text.

8.4 CLICK AND TYPE

This feature allows you to insert text any where in a page. Move the
cursor in a page where you want to insert the text. Double-click and
start typing. Click and Type is also useful for inserting tables, charts
and other graphics in a blank area of a document. When you insert
an item, Click and Type automatically formats the item according to
where you insert it.

8.4.1 Inserting (Typing) Special Characters (Symbols)

Word supports a set of special characters and symbols, which can-
not be entered through the keyboard. To insert these special char-
acters and symbols, follow the steps given below:

1. Move the cursor where you want to place the symbol and click.
Observe that the insertion pointer appears at the point.

2. Choose Insert = Symbol command on the menu bar. The Sym-
bol dialog box appears. The dialog box displays all available sym-
bols for respective fonts.
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3. Click on Symbols tab if it is not highlighted. Click on the symbol
you want to insert, the symbol displays an enlarged version of
the symbols. Press Insert to place the symbols at the present
cursor position in the document. You can also do this action by
simply pointing the cursor on the symbol and the double-click-
ing.

4. Click on Close to close the Symbol dialog box.

The Special Characters tab includes additional characters such an
Em and En spaces, Em and En dashes, nonbreaking hyphens,
nonbreaking spaces, C,R etc. To insert special characters, follow the
steps given below:

1. Repeat step 1 and 2 above.

2. Click on Special Characters tab to see the special characters
available in the symbol dialog box. Click on the special character
you want to insert. Press Insert button to place the special char-
acter at the present cursor position in teh document. You can
also do this action by simply pointing the cursor on the special
character and the double-clicking.

3. Click on Close to close the Symbol dialog box.
8.5 UNDO AND REDO

Feel free to experiment with various text styles. You can always
undo your last action by clicking the Undo button on the Standard
toolbar or selecting Edit & Undo command on the menu bar. Click
the Redo button on the standard toolbar or select Edit © Redo
command on the menu bar to erase the undo action.

8.6 FORMATTING TEXT

Using the Formatting toolbar is the easiest way to change many
attributes of text. If the toolbar as shown below is not displayed on
the screen, select View = Toolbars command on the menu bar and
choose Formatting command.

Style Menu - Styles are explained in detail later in this lesson.

Font Type - Font is the basic typeface in which your words are
displayed. Font comes in families such as Times New Roman or
Ariel. Each font family has a specific way of formatting individual
letters. Click the arrowhead to the right of the font name box in the
Formatting toolbar to view the list of fonts available. Scroll down to
the font you want and select it by clicking on the name once with
the mouse.
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Font size - [t determines how large each letter will appear. The font
size is measured in points (1/72 of an inch). Click on the white part
of the font size box in the Formatting toolbar to enter a value for a
font size or click the arrowhead to the right of the box in the For-
matting toolbar to view a list of font sizes available. Select a size by
clicking on it once. A font size of 10 or 12 is best for paragraphs of
text.

Font Style - Font style determines the emphasis or weight that the
letters have when they are displayed. Each font can be displayed as
bold, italicize, and underline.

Alignment - Text can be aligned to the left, center, or right side of
the page or it can be justified across the page.

Numbered and Bulleted Lists.

Increase/Decrease Indent - Change the indentation of a paragraph
in relation to the side of the page.

Out side Border - Add a border around a text selection.

Highlights Color - Use this option to change the color behind a text
selection. The color shown on the button is the last color used. To
select a different color, click the arrowhead next to the image on the
button.

Text Color - This option changes the color of the text. The color
shown on the button is the last color chosen. Click the arrowhead
next to the button image to select another color.

8.6.1 The Font Dialog Box

The Font dialog box allows you to choose from a larger selection of
formatting and using Formatting toolbar is the easiest way to format
text. If you cannot format text using Formatting toolbar, then use
Font dialog box options. Select Format < Font command on the
menu bar to access the Font dialog box.

8.6.2 Format Painter

A handy feature for formatting text is the Format Painter located
on the Standard toolbar, For example, if you have formated a para-
graph heading with a certain font face, size, and style and you want
to format another heading the same way, you do not need to manu-
ally add each attribute to the new headline, use the Format Painter
by following these steps:
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1. Place the cursor within the text that contains the formatting you
want to copy.

2. Click the Format Painter button in the standard toolbar. Notice
that your pointer now has a paintbrush beside it.

3. Highlight the text you want to add the same format to with the
mouse and release the mouse button.

To add the formatting to multiple selections of text, double-click the
Format Painter button instead of clicking once. The format painter
then stays active until you press the ESC key to turn it off.

INTEXT QUESTIONS

1. The keyboard combination for a non-breaking space between two
words:

(a) ALT+SHIFT
(b) SHIFT+ENTER
(c) CTRL+SHIFT+SPACEBAR
2. What will happen to the cursor when you use the following key-
board shortcuts?
(a) HOME,
(b) END,
(c) CTRL+HOME,

(d) CTRL+END

3. What are the shortcuts for selecting:
(a) a whole word,
(b) whole paragraph,

(c) several words or lines,
(d) entire document

4. State True or False

(a) Itis a good practice to insert many spaces you need to move
a text across a line.

(b) We can use BACKSPACE key to delete smaller selection of
text.

(c) Ariel is a style menu name.
(d) The font size is measured in points.
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8.7 FORMATTING PARAGRAPHS

In Word, a paragraph is any amount of text, graphics, object or other
items that are followed by a paragraph mark. A paragraph mark is
inserted each time while pressing the ENTER key. In order to change
the formatting of a paragraph, select the paragraph and then apply
the formats. Paragraph format affects the entire paragraph and new
paragraphs keep the formatting of the preceding paragraph. Para-
graph marks store the format of each paragraph. If the paragraph
mark is deleted, the text in that paragraph becomes part of the next
paragraph.

You can format a paragraph by placing the cursor within the para-
graph and selecting Format - Paragraph command on the menu
bar.

8.7.1 Line Markers

To insert a new line mark in the same paragraph, press
SHIFT+ENTER keys. This action pushes the text down to the next
line, but does not create a new paragraph. To modify the appear-
ance of paragraph, use the Ruler, the Formatting toolbar and the
Paragraph dialog box or one of Word’s paragraph formatting short-
cut key combinations. The various ways in which the paragraph
formatting can be done is described in the following subsections:

8.7.2 Centering, Right Alignment and Left Alignment

By default, the text in Word is left aligned. But these alignments
can be changed as described earlier.

8.7.3 Indenting Text
Indenting a paragraph enables it to set off from other text.

e To indent paragraphs automatically, drag the top half of the tri-
angular indent mark of the horizontal ruler to the right of the
desired position. Alternatively, you can select Format - Para-
graph command on the menu bar. The Paragraph dialog box
appears. Select First line under Special: drop down submenu
and then type indent-length in inches in the box under By: in
the Paragraph dialog box to indent only the first line of a para-
graph.

e To increase or decrease indents by one Tab stop, use the In-
crease Indent and Decrease Indent button on the Formatting
toolbar.
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e To create a hanging indent (that indents all lines but the first
line of a paragraph, drag the top half of the triangular indent
marker in the horizontal ruler to the left of the desired position.
You can also select Format - Paragraph command on the menu
bar. The paragraph dialog box appears. Select Hanging under
Special: drop down submenu and then type indent length in
inches in the box under By: in the Paragraph dialog box to in-
dent all but the first line of a paragraph.

e If you have earlier indented either First line or Hanging all lines
but the first line and now want to remove the indentation, select
(none) under Special: drop down submenu in the Paragraph dia-
log box. You can also use drag-and drop method explained above.

8.7.4 Tab Stops

By default, the tab Stops are set at 0.5-inch intervals from the left
margin. To increase or decrease the tab length Choose Format -
Tabs command on the menu bar. The tab dialog box appears. Type
the length of the tab in inches in the box under Tab stop position of
Tabs dialog box. Click on OK. The insertion point can be moved to
the next tab stop in the current paragraph by pressing the Tab key.

You can also use the horizontal ruler to set a tab stop at a particular
position or to change the way text lines up at a tab stop by simply
moving the cursor to a place on the horizontal ruler and clicking.

To set tab stops:

1. Select the paragraph in which you want to set or change tab
stops.

2. To set or change the tab alignment, click the Tab Alignment
button at the far left of the horizontal ruler until the tab align-
ment is the way you want to be.

To select the respective Tabs click on:
Left-aligned tab stops

Centered tab stops

Right-aligned tab stops

Decimal tab stops

To move a tab stop, point to the tab marker and drag it to a new
position. To clear a tab stop, drag the tab marker off the ruler.
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Also, you can set precise measurements for tab stops by using the
Tabs command on the Format menu.

The spacing between the default Tab Stops can also be changed but
this will affect only the active document. To do this, type or select
the distance you want between the tab stops in the Default Tab
Stops box and then click the OK button in the Tabs dialog box.

8.7.5 Line Spacing

Line Spacing determines the height of each line of text in the para-
graph. The default (single line spacing) depends on the size of the
font characters. Individuals line spacing is easy to change.

Choose Format - Paragraph command on the menu bar. The Para-
graph dialog box appears. The Indents and Spacing tab of the Para-
graph dialog box provides a drop-down under Line spacing: for
simple but effective control of the space between lines under most
circumstances. The preview area demonstrates the relative effects of
single, one-and-a-half and double line spacing. Single spacing causes
12-point line spacing, 112 line spacing is 18 points and double
spaced lines will be 24 points apart.

All these line spacing settings can be made by choosing the appro-
priate from the Line spacing menu in the Paragraph dialog box.

When you use these choices, Word will compensate for graphics,
superscript and large or small type sizes.

8.7.6 Paragraph Spacing

Word enables each paragraph to give unique before and after spac-
ing if you wish. The spacing settings can be in points (pt), inches
(in), centimetres (cm), or lines (li). Headings often have different
spacing requirements for body text. For instanc, you may require
different before and after spacing designs for figures and figure cap-
tions as well. Also you can have unique spacing specification as part
of a style, making it easy to keep the look of your documents consis-
tent.

Choose Format - Paragraph command on the menu bar. The Para-
graph dialog box appears. Use drop down submenu in Before: and
After: under Spacing of the Paragraph dialog box to set the para-
graph spacing.

The advantages of using the Paragraph command are:
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1. Spacing before and after paragraphs does not change the point
size of your text.

2. You can use different spacing combinations for different pur-
poses.

3. You can make precise adjustments to the spacing between the
various text elements. For example, you can use paragraph spac-
ing to clarify the relationship between headings and body text.

4. If the paragraph is moved or deleted, its spacing goes with it. The
paragraph doesn’t leave behind extra blank lines.

5. If you include spacing in the paragraph styles you use to format
text, Word adds the space along with the other formatting. You
need not add blank lines manually.

8.8 BORDERS AND SHADING

you can add borders to any side of a paragraph and you can add
background shading also you can also add borders and shading to
ordinary text and to the paragraphs in table cells and frames. Choose
Format - Borders and Shading command on the menu bar. The
Borders and Shading dialog box appears. Click on the appropriate
borders box after selecting Borders tab to select border, select Para-
graph under Apply to: drop down submenu, Click OK. To shade a
paragraph, click on Shading tab in Borders and Shading dialog box,
select appropriate shade under Fill, and select Paragraph under
Apply to: drop down submenu, click OK.

8.8.1 Columns

To quickly place text of a paragraph in a column format, click the
Columns button on the Standard toolbar and select the number of
columns by dragging the mouse over the diagram. Using this fea-
ture of the Standard tool bar and can have up to 4 columns in a
paragraph. To format the paragraph into more than one column,
follow the steps given below.

1. Select the paragraph you want to have more than one column.

2. Move the cursor on columns button on the Standard command
on the menu bar. The Columns dialog box allows you to choose
the properties of the columns. Select the number and width of
the columns from the dialog box.

For more column options, select Format - Columns command on
the menu bar. The Columns dialog box allows you to choose the
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properties of the columns. Select the number and which of the col-
umns from the dialog box.

8.8.2 Drop Caps

A drop cap is a large letter that begins a paragraph and drops through
several lines of text as shown below.

Add a drop cap to a paragraph by following these steps:

1.

4.

Place the cursor within the paragraph whose first letter will be
dropped.

. Select Format - Drop Cap command on the menu bar.

. The Drop Cap dialog box allows you to select the position of the

drop Cap. The font, the number of lines of drop, and the distance
from the body text.

Click OK when all selections have been made.

To modify a drop cap, select Format - Drop Cap again to change
the attributes, or click on the letter and use the handles to move the
and resize the letter.

INTEXT QUESTIONS

5.

6.

7.
8.

The shortcut key to insert a new line:
(a) ENTER

(b) SHIFT+ENTER

(c) ALT+ENTER

By default, the Tab stops are set at:
(a) 0.3 inch intervals
(b) 0.4 inch intervals

(c) 0.5 inch intervals

What is a drop cap?

State True or False

(a) One and half line spacing causes 16 points.

(b) Using Standard toolbar, you can have up to 4 columns in a
paragraph.

(c) Format Painter button on the Standard toolbar is useful in
applying a style.

(d) Single spacing causes 12 point line spacing.
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8.9 BULLETED AND NUMBERED LISTS

Bulleted lists and Numbered lists are often used to bring main points
to a reader’s attention.

8.9.1 Creating a Bulleted and Numbered Lists

To create a bulleted or numbered list, use the list features provided
by Word. In this section you will learn how to create format bulleted
and numbered lists.

1. Click the Bulleted List button or Numbered List button on the
formatting toolbar.

2. Type the first entry and press ENTER. This will create a new
bullet or number on the next line. If you want to start a new line
without adding bullet or number, or hold down the SHIFT key
while pressing ENTER.

3. Continue to type entries and press ENTER twice when you are
finished typing to end the list.

Use the Increase Indent and Decrease Indent buttons on the for-
matting toolbar to create lists of multiple levels.

You can also type the text first, highlights the section, and press the
Bulleted List or Numbered List buttons to add the bullets or num-
bers.

8.9.2 Creating Nested Lists

To create a nested list, such as a numbered list inside of a bulleted
list, follow these steps:

1. Type the list and increase the indentation of the items that will
make up the nested list by clicking the Increase Indent button
for each item.

e Lists

e Bulleted and Numbered Lists
e Nested Lists

e Formatting Lists

e Tables

o Create a Table

2. Highlights the items and click the Numbered List button on the
formatting toolbar.
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8.9.3 Formatting Bulleted and Numbered Lists

The bullet image and numbering format can be changed by using
the Bullets and Numbering dialog box.

1. Highlight the entire list to change all the bullets or numbers, or
Place the cursor on one line within the list to change a single
bullet.

2. Access the dialog box by selecting Format - Bullets and Num-
bering command on the menu bar or by right-clicking within
the list and selecting Bullets and Numbering command from the
shortcut menu.

3. Select the list style from one of the seven choices given, or click
the Picture... button to choose a different icon. Click the Num-
bered tab to choose a numbered list style.

4. Click OK when finished.
8.10 COPYING TEXT AND MOVING (CUTTING) TEXT

Part of editing process of text is copying or moving text to other
locations of your document. You can use the copy and cut com-
mands to avoid retyping text in your document. This deals with the
use of clipboard in copying and moving text within a document or
into other documents. When you copy or cut text, the text is stored
in an area of memory called clipboard and can be pasted back into
the document or into any other document. The last 12 elements
that were cut or copied are placed onto Word’s clipboard. You can
view the elements on the clipboard by selecting. View = Toolbars
-> Clipboards command on the menu bar.

Place the mouse arrow over the each element in the clipboard to
view the contents of each item and click on an element to add its
contents to the document. Click Paste All to add all of the items to
the document at once. Click the Clear Clipboard button (the icon
with an “X” over the clipboard image) to clear the contents of the
clipboard.

8.10.1 Moving (Cutting) Text

Moving text means to remove (cut) the selected text from the one
location and insert it in another location. To move text follow the
steps given below:
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1. Select the text that will be moved.

2. Select Edit->Cut command on the menu bar, or click the Cut
button on the standard tool bar, or press CTRL +X. This will
move the text to a clipboard.

3. To paste cut text move the cursor to the location you want to
move the text to and select Edit>Paste command on the menu
bar, click the Paste button on the standard toolbar, or press
CTRL+V.

To move a small amount of text a short distance, the drag-and-drop
method may be quicker. Highlight the text you want to move, click
the selection with the mouse, drag the selection of the new location,
and release the mouse button.

8.10.2 Copying Text

Copying means to make a copy of the selected text and insert in
another location, leaving the original text unchanged in layman’s
language it is same as duplication. To copy text, follow the steps
given below:

1. Select the text that will be moved.

2. Select Edit - Cut command on the menu bar, or click the Cut
button but button picture on the standard toolbar, or press
CTRL+X. This will move the text to a clipboard.

3. Choose Edit & Copy command on the menu bar, Click the Copy
button on the standard toolbar, or press CTRL+C to copy the
text to the clipboard.

8.11 SPELLING AND GRAMMAR

The spelling and grammar checkers check for misspelled words or
grammar errors. The red wavy lines will appear underneath mis-
spelled words. The green wavy lines will appear underneath gram-
matical errors. This section deals with the concepts and commands
of spelling and grammar corrections of yours document.

8.11.1 AutoCorrect

Word automatically corrects many commonly misspelled words and
punctuation marks with the AutoCorrect feature. To view the list of
words that are automatically corrected, select Tools - Auto Cor-
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rect command on the menu bar. This may be a hidden feature so
click the double arrows at the bottom of the Tools menu listing if
the AutoCorrect choice is not listed.

Many options including the accidental capitalization of the first two
letters of a word and capitalization of the first word of the sentence
can be automatically corrected from this page. If there are words
you often misspell, enter the wrong and correct spellings in the
Replace and With fields.

8.11.2 Spelling and Grammar Check

Word will automatically check for spelling and grammar errors as
you type unless you turn this feature off. Spelling errors are noted
in the documents with red underline. Grammar errors are indi-
cated by a green underline. To disable this feature, select Tools -
Options command on the menu bar and click the Spelling and
Grammar tab on the dialog box. Uncheck “Check spelling as you
type” and “Check grammar as you type”, and click OK.

To use the spelling and grammar checker, follow these steps:

1. Select Tools - Spelling and Grammar command on the menu
bar.

2. The Spelling and Grammar dialog box will notify you of the first
mistake in the documents and misspelled words will be high-
lighted in red.

3. If the word is spelled correctly, click the Ignore button or click
the Ignore All button if the word appears more than once in the
document.

4. If the word is spelled incorrectly, choose one of the suggested
spellings in the Suggestions box and click the Change button or
Change All button to correct all occurrences of the word in the
document. If the correct spelling is not suggested, enter the cor-
rect spelling in the Not In Dictionary box and click the Change
button.

5. If the word is spelled correctly and will appear in many docu-
ments you type (such as your name), click the Add button to add
the word to the dictionary so its will no longer appear as mis-
spelled word.

As long as the Check Grammar box is checked in the Spelling and
Grammar dialog box, Word will check the grammar of the document
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in addition to the spelling. If you do not want to grammar checked,
remove the checkmark from this box. Otherwise, follow these steps
for correcting grammar:

1.

If Word finds a grammatical mistake, it will be shown in the box
as the spelling errors. The mistake is highlighted in green text.

. Several suggestions may be given in the Suggestions box. Select

the correction that best applies and click Change.

. If no correction is needed (Word is often wrong more than it is

right), click the Ignore button.

8.11.3 Add a New Word to Custom Dictionary

To add a word a Custom dictionary that is not in Dictionary follow
the steps given below:

1.
2.

Open the file you want to check Spelling and Grammar.

Activate the Spelling and Grammar checker by pressing F7 Key
on the keyboard or click on the Spelling and Grammar button on
the standard toolbar on the standard toolbar or choose Tools
spelling and Grammar... command on the menu bar.

. When the Spelling and Grammar checker pauses on a word that

is not in its dictionary that you think should be part of the Cus-
tom dictionary, click on the Add button on the right side of the
dialog box.

8.11.4 Remove a Word from Custom Dictionary

If you have inadvertently added a word, you can edit the Custom
dictionary and remove the word. To remove a word from Custom
dictionary follow the steps given below:

1.

2.

Open any existing file to remove word (s) from the Custom dictio-
nary.
Choose Tools - Options: The Options dialog box appears.

3. Click the Spelling & Grammar tab if it is not highlighted. Click

on the Dictionaries button. When the dictionary appear,
CUSTOM.DIC will be selected, because the custom dictionary is
currently open in memory and being used in conjunction with
Word’s propriety dictionary.

. Click on the Edit button at the bottom of the dialog box (do not

choose the Remove bottom).
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5. Word shows the contents of the Custom dictionary in a Docu-
ment. Scroll down and look at the words. Delete or edit the words
you do not wish to have in the dictionary.

6. Save the Custom dictionary by clicking on the Save button on
the Standard toolbar or choose File = Save command on the
menu bar.

7. Select File & Close command on the menu bar to return to your
document.

8.11.5 Synonyms

Word 2000 has a new feature for finding synonyms. Simply right-
click on the word and select Synonyms from the shortcut menu.
From the list of suggest words, highlights the word you would like to
use or click Thesaurus... for more options.

8.11.6 Thesaurus

To use the thesaurus, select Tools 2 Language - Thesaurus from
the menu bar or select it from the Synonyms shortcut menu as
detailed above.

A list of meanings and synonyms are given on the windows. Double-
click on the words in the Meanings box or click the Look Up Button
to view similar words. Double-click words in the Replace with Syn-
onyms box to view synonyms of those words. Highlights the word
you would like to add and click the Replace button.

INTEXT QUESTIONS

9. The command in the menu bar is used in
access the Bullets and Numbering dialog box.

10. What is the difference between copying text and moving text?

11. To view the elements on a clipboard, you select
command from the menu bar.

12. State True or False

(@) Choosing Edit & Copy command on the menu bar and press-
ing CTRL+C keys are different actions.

(b) You cannot use Custom dictionary to remove a word.

() You can select synonyms of a word from shortcut menu by
right click.
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(d) The Spelling and Grammar checker can be activated by
pressing F7 on the keyboard.

8.12 WHAT YOU HAVE LEARNT

In this lesson you learnt about various features of formatting text.
You are now in a position to move text from one place to another
and apply different font and character styles. Also you can apply the
grammar and spell-check features of MS-Word.

8.13 TERMINAL QUESTIONS.

1.

® N o 0 & L N

What is the command in the menu bar to change text to Title
Case?

What is the advantage of click and type?

Describe the various steps in inserting a symbol.
What is a font type? Mention any two font families.
How do you set line spacing in a paragraph?

Write steps in moving text.

Write steps in copying text.

Explain use of AutoCorrect feature in Word.

8.14 KEY TO INTEXT QUESTIONS

—

(c) (CTRL+SHIFT+SPACEN/BAR)

(a) Beginning of the line

(b) End of the line

(c) Top of the document

(d) End of the document

(a) Double-click within the word

(b) Triple-click within the paragraph

(c) Drag the mouse over the words, or hold down SHIFT key
while using the arrow keys.

(d) Choose Edit - Select All command on the menu bar or
press CTRL+A keys.

(a) False, (b) True, (c) False, (d) True




172 :: Basic Computing Skills

5. (b) (SHIFT + ENTER keys)
6. (c) 0.5 inch intervals

7. A drop cap is a large letter that begins a paragraph and drops
through several lines of text.

8. (a) False, (b) True, (c) True, (d) False
9. Format Bullets and Numbering

10. Copying means to make a copy of the selected text and the
insert in another location, leaving the original text unchanged.
Moving text means to remove the selected text from one location
and insert it in another location.

11. View - Toolbars - Clipboard
12. (a) False, (b) False, (c) True, (d) True




